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Introduction to the software Mosaic 2000
Mosaic 2000 is a software for the creation of mosaic decorations.
A mosaic can be created tile by tile, or from an existing image. A computer image
is made of pixels of different colors. In the same way, a mosaic is made of tiles of
different colors. However mosaics have a lower resolution (spatial resolution or
number of colors) than most of the existing computer images. In order to decrease these
two kinds of resolutions, image processing functions are available. The resize
processing adjust the spatial resolution of an image. In a computer image, pixels may
have a lot of colors, but the tiles for a given manufacturer have a palette from 20 to 50
colors. The color reduction processing diminish the number of image colors. Another
function of the software is the drawing tile by tile of a mosaic. Half-stone tiles (or
triangle) and rectangles can be created. A mosaic of a text can be realized easily. Non
rectangular mosaics (like mirrors or grounds) can be constructed. Color blending can be
generated.
For the building, a mosaic is decomposed into grids. A grid describes the
arrangement of a given number of tiles. (As an example: a grid of 12 x 12 tiles). The
software prints each grid on one or several sheets, then these sheets are glued each
other. On a grid is printing for each tile a number corresponding to its color. As an
example, the number 0 corresponds to a white tile, and the number 1 corresponds to a
blue tile. A symbol can also be printed to remplace numbers (Example: W for White,
and Bu for Blue).

Advice card 1: Material
Material list
- Grid of gluing : its function is the regular arrangement of tiles. If the joint has the
same size as the one that is on self-colored industrial grids (given by the
manufacturer), a mosaic can be inserted inside self-colored tiles.
- Glue and mesh in the case of laying with the reverse method.
- Gummed paper in the case of laying with the direct method.
- Cuter and iron rule.
- Brush and White Spirit.
- Labels.
- Hair drier (or blower) to drying the glue.
-Tiles in function of the colors on the mosaic (Standard tile size are: 9x9 mm, 10x10
mm, 19x19 mm, 20x20 mm, 24x24 mm, 25x25 mm or 0.75x0.75 inch, 1x1 inch).

Material choice
- The tiles may be colored on only one side, or on the 2 sides. In the case, of one side
colored tile, and the use of the laying on gummed paper, we cannot verify the mosaic
before the laying into mortar. (because we see only the uncolored side after the
gluing on paper).
- Attention: Some manufacturers label their tiles as 20x20 mm, but in reality they
measure 19x19 mm. Because they take into account the joint size. A sample of tiles
is better to measure exactly the tile size, before to order for a grid of gluing.

Advice card 2:
Choice of a mosaic image
The different ways to obtain a mosaic image are:
·
·
·

Draw the mosaic with the software tile by tile.
Give to a graphic designer (or an artist) the subject of the mosaic, and give him
an empty mosaic grid. (For this, do: File/New then File/Print with the option
View Joint).
Use existing numerical images with available image processing functions. The
numerical images can be taken from:
1. an image database
2. internet
3. a scanned photo
4. a numerical camera
To use an image for doing a mosaic, it is necessary to ask the autorization to its
author, in the case where the image is not royalty free.
Table of the size of mosaics in meters and in tiles
(for tiles of 25 x 25 mm, with a space between tiles of 1.6 mm).

Table top
Bathroom wall
Shower wall
Rose
Swimming pool

Dimensions (in meters)
0,532 x 1,33 m
2,66 x 1,862 m
0,665 x 1,862 m
0,931 x 0,931 m
3,99 x 7,98 m

Resolution (in tiles)
20 x 50 tiles
100 x 70 tiles
25 x 70 tiles
35 x 35 tiles
150 x 300 tiles

Advice Card 3:
Steps of the mosaic building
1. Printing of tile laying plan for the mosaic (Mosaic / Grid printing), and the
inquiries page (Mosaic / Inquiries / Print).
2. Gluing the sheets, in order to build the different grids.
3. Printing of a mosaic image (File / Print with Option View grids) for give to the
tiler the grids arrangement.
For each grid:
1. Put the grid under the grid of gluing.
2. Put the tiles in the grid of gluing in function of the correspondence
numbers/colors (as specified in the inquiries page). In the case of laying on a
mesh (indirect method or reverse method), the colored side of the tile is against
the grid of gluing, and inversely in the case of laying on paper (direct method).
3. Incline the grid of gluing to align correctly all the tiles.
4. Put glue on the mesh (the mesh has been cutted to the size of a grid).
5. Press the mesh on the tiles, and wait about 20 minutes to dry the glue. Use the
hair drier to accelerate the gluing.
6. In the case of laying on gummed paper, put water on the paper, and then press
the paper on the tiles.
7. Glue a label, with the number of the grid to the top-left of the grid.
Remarks:
· Before the laying into mortar, verify the mosaic by putting the grids on the floor
in the printed arrangement.

Standart Toolbar
Click

To

Create a new mosaic.

Open an existing mosaic.

Save the active document or temgrid with its current name.

Print the active mosaic.

Undo the last action.

Realize a zoom + of the image.

Realize a zoom - of the image.

Display the joint between tiles.

Display grids.

Display Rulers.

Toolbar / Zoom
When an image is open, the zoom level is setup automatically, to see all the
image.
To the minimum zoom level, joints are not shown. Elevators (horizontal and
verticals bars) are displayed when the display zone is smaller than the image at the
given zoom level. To see all the parts of the image, you have to move with the
elevators.

Toolbar / Rulers
The ruler allows a better locating of tiles.
The horizontal ruler is in characters (A, B, .., AA, AB,..), while the vertical ruler
is numerical (1, 2,...).
The display rulers are corresponding to the printed rulers.
With the reverse method, the character ruler (vertical) is inverted, but is in its
normal order at the printing.
Call:
on the toolbar

Drawing Toolbar
Click

To

Tile color reading

Rectangle selection

Tile drawing
Triangle drawing
Rectangle drawing

Generates a color blending in a region

Generates a transparent region

Region filling with a color

Replace a color by another

Eraser

Generates a text mosaic

Width measure: Indicate the horizontal dimension (in real units).
Height measure: Indicate the vertical dimension (in real units)

Drawing toolbar / Tile Drawing
Drawing of a tile on the mosaic.Select its color into one of the two palettes.
Call:
on the toolbar

Drawing toolbar / Triangle drawing
Drawing of a triangle on the mosaic.
Select its color into one of the two palettes. Click on one of the 4 corners of the
tile. To each corner is corresponding a position of the triangle.
To rotate the last clicked triangle, you can press on the left or on the right arrow
key.
For the true alignment of 2 triangle tiles in the grid of gluing, you can use
matches.
Call:
on the toolbar

Drawing toolbar / Rectangle drawing
Drawing of a rectangle on the mosaic.
Select its color into one of the two palettes. Click on one of the 4 sides of the tile.
To each side is corresponding a position of the rectangle.
To rotate the last clicked rectangle, you can press on the left or on the right arrow
key.
Call:
on the toolbar

Drawing toolbar / Generates a Color Blending in a region
This command generates a color blending (or gradient).
Color blendings are currently used is the world of mosaic.
A region is an homogeneous part of the image (Eg : region with the blue color).
Click on the region in which you want to generates the color blending, and then enter the
parameters.
In a first time, select the colors for the blending, among the colors of the current
palette. A blending is composed of stairs. Stairs may be horizontal or vertical. As an
example, if the image has 4 vertical stairs, it will be splitted in 4 equal parts from top to
bottom. The stair percentage indicates for each color the quantity of tile in a stair.
Percentage may be fixed manually or by the computer.
By a click on the button Options, you can access to a grid to define the color
functions.
If the function increase : Start = 10 % and Step = 5 %, then :
Stair 0 : 10 % Stair 1 : 15 % Stair 2 : 20 % Stair 3 : 25 % .....
If the function decrease : Start = 50 % and Step = 10 %, then :
Stair 0 : 50 % Stair 1 : 40 % Stair 2 : 30 % Stair 3 : 20% ...
If the function is linear : Start = 10 %, then :
Stair 0 : 10 % Stair 1 : 10 % Stair 2 : 10 % Stair 3 : 10% ....
The total percentage of all the colors for a given stair must be equal to 100%.
The program compute at first, percentages for increase and decrease functions.
Then, the linear function are computed to have 100%.
Several tests of different percentages must be done before to find a nice color
blending.
If the percentage is over 100%, an error message is displayed

Drawing toolbar / Generates a transparent region
This command allows to build non rectangular mosaics, by unvalidate image
regions. (For mirrors, or non rectangular grounds).
A region is a part of the image with the same color.
Select this tool and click on the region that you want to make transparent.
When tiles of the selection region are transparent, corresponding tiles are not
displayed, and grids of unvalidate regions are not generated.

Example of a mirror : The grids are not generated inside the miror.

Drawing toolbar / Region filling
Fill an image region with a given color by another color. Select its color into one
of the two palettes. Click on an image region to change its color.

Drawing toolbar / Color replace
Replace a color by another in the whole image. Select a color into one of the two
palettes. Click on the image, on the color to replace. The difference with the region
filling, is that with this tool several regions of the image can be modified in the same
time.
Call:
on the toolbar

Drawing toolbar / Eraser
Erase 3x3 tiles around the clicked position.Select its color into one of the two
palettes. To erase a bigger surface, move the eraser on the image while maintaining the
mouse left button pressed.
Call:
on the toolbar

Drawing toolbar / Text
The text tool allows to realize a text into a mosaic. Choose the font, style, and
character size in a first dialog box.
In the second dialog box, type the text.
To choose the color of the text tiles, click on a color in one of the two palettes.
Then move the text with the mouse on the image to the wanted position. Then,
click on the mouse left button, and the text is placed on the image.
Call:
on the toolbar

File menu commands
The File menu offers the following commands:
New
Creates a new mosaic.
Open
Opens a mosaic.
Save
Saves an opened mosaic.
Save As
Saves an opened mosaic to a specified file name.
Mosaic Export
Exports a mosaic image.
Print
Prints a mosaic.
Print Preview
Displays the mosaic on the screen as it would appear printed.
Print Setup
Select the printer options.
Options
Program options.
Exit
Exits Mosaic 2000.

File / New
Use this command to create a new mosaic.
A dialog box ask for the dimension (Width and height in number of tiles) of the
mosaic to create.
Shortcuts:
on the toolbar
or keys: CTRL+N

File / Open
Use this command to open an existing image.
Image formats recognized by the program are:
Windows or OS/2 Bitmap : *.bmp
JPEG : *.jpg
Zsoft Paintbrush : *.pcx
Adobe Photoshop : *.psd
Kodak PhotoCD: *.pcd
PNG : *.png
Truevision Targa : *.tga
Tagged Image File Format : *.tif
Wireless Bitmap : *.wbmp
The mosaic file extension created by the program is *.ms2
Images with more than 245 colors are automatically quantized to 245 color images.
Shortcuts:
on the toolbar
or keys: CTRL+ O

File / Save
Use this command to save the active image to its current name and directory.
When you save a document for the first time, Mosaic 2000 displays the Save As
dialog box so you can name your image.
Shortcuts:
on the toolbar
or keys: CTRL+ S

File / Save As
Use this command to save and name the active mosaic. Mosaic 2000 displays the
Save As dialog box so you can name your mosaic.
The following options allow you to specify the name and location of the file
you're about to save:
File Name
Type a new filename to save a document with a different name.
Drives
Select the drive in which you want to store the document.
Directories
Select the directory in which you want to store the document.

File / Mosaic Export
The mosaic export command allows to save the result image of the mosaic to be
used by another software (like a word processor or a web navigator).
The command attributes a default name to the exported image with the addition
of _M to the original name. The user can choose another name.
The exported image size is function of the zoom. The more the zoom is high, the
more the image is large.

File / Print
Use this command to print an image. This command presents a Print dialog box,
where you may specify the range of pages to be printed, the number of copies, the
destination printer, and other printer setup options.
The size of the printed image is linked to the zoom level at the image display.
The printing is on one page.
Shortcuts:
on the toolbar
or keys: CTRL+ P

File / Print Preview
Use this command to display the image as it would appear when printed. When
you choose this command, the main window will be replaced with a print preview
window in which one or two pages will be displayed in their printed format. The print
preview toolbar offers you options to view either one or two pages at a time; move back
and forth through the document; zoom in and out of pages; and initiate a print job.

File / Print Setup
The following options allow you to select the destination printer and its
connection.
Printer
Select the printer you want to use. Choose the Default Printer; or choose the Specific
Printer option and select one of the current installed printers shown in the box. You
install printers and configure ports using the Windows Control Panel.
Orientation
Choose Portrait or Landscape.
Paper Size
Select the size of paper that the document is to be printed on.
Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.

File/ Options
In this dialog box, the user can choose the program options.
The first option concern the measure units (millimeters or inches).
The second option is for the selection of the paper format (A4 or US Letter).
The third option is for the money unit. (Dollar, Euro, ...).

File / Command 1, 2, 3, 4
Use the numbers and filenames listed at the bottom of the File menu to open the
last four documents you closed. Choose the number that corresponds with the mosaic
you want to open.

File / Exit
Use this command to end your Mosaic 2000 session.
Shortcuts
Keys: ALT+ F4

Edit menu commands
The Edit menu offers the following commands:

Undo
Undo the last action.
Copy
Copy the selection rectangle into clipboard.
Paste
Paste the clipboard into the selection rectangle.
Mirror
Realize a mirror on the selection rectangle.
Lines/Columns
Adds or suppress lines or columns.

Edit / Undo
The undo command cancels the last action realized.
After the realization of a given action X, this command become Cancel X, and
with the selection of this command, the image become again like it was before the last
action.
Shortcuts:
on the toolbar
or keys: CTRL+ Z

Edit / Copy
Copy the selected part of the image by the selection rectangle into clipboard.
Click on this button to create a selection rectangle.
Then click on the image, while maintaining the mouse left button pressed, choose
the size of the rectangle, then unpress the mouse left button.
The selection rectangle can be resized by clicking on handles, then drag the
mouse while maintaining the mouse left button pressed.
The handles disappear when the copy is done, and the rectangle can be moved on
the screen, by clicking inside the rectangle while maintaining the mouse left button
pressed and dragging the mouse.
To cancel a selection rectangle, just click outside of the rectangle.
The copy will be restored by a paste action, after that the selection rectangle has
be moved.
The Edit Menu can be directly called by a click on the mouse right button, inside
of the selection rectangle.
Shortcuts:
Keys: CTRL+ C

Edit / Paste
Paste the clipboard into the selection rectangle.
Many paste actions can be done successively. In this case, an undo action will be
effective only on the last paste.
Shortcuts:
Keys: CTRL+ V

Edit / Mirror
The mirror command realizes a mirror processing of the selection rectangle.
·
·

horizontal (the pixels to the right are find oneself to the left, and inversely),
vertical (the pixels to the top are find oneself to the bottom, and inversely).
This command is possible with the use of triangle or rectangle tiles.
To do a mirror of the full image, just select all the image into the selection
rectangle.
The Copy/Paste and the Mirror can create symmetrical roses, with the drawing
of only the quarter of the pattern.

Edit / Lines/columns
The Lines/columns command adds or suppress lines or column to the different
mosaic borders.
A dialog box ask for the location of the insertion and the number of lines or
columns to add or suppress.

Processing menu commands
The processing menu is destined to the transformation of an image into a mosaic.
Each processing is reversible one time, by a press on Undo.
The Processing menu offers the following commands:

Resize
Image resizing.
Color reduction
Image color reduction.
Smoothing
Image smoothing.
Triangle generation
Generates triangle tiles

Processing / resize
The resize command reduces the image size (or spatial resolution).
Indicates the expected size for the mosaic, then the program automatically resize
the image. Select width or height corresponding to the expected size.
Mosaic size = Pixel number * (Tile size + Joint size).
In the case of several trials, do an Undo resize between 2 trials, to preserve the
initial accuracy.
A message in the status bar indicates the image resolution before and after resize.

Processing / Color Reduction
The color reduction command reduces the number of image colors, and generates
an image with colors belonging to the tile palette colors, among the one selected in
advance.
This processing is destined to images with a great number of colors, or for the
images with colors different to the palette tile.
The command attributes to each pixel of the input image, its nearest color of its
own color among the colors of the tile palette. In this context, the input image can loose a
number of colors. If 2 colors of the input image are near from only one color of the tile
palette, then in the output image, the 2 colors are replaced by only one color.
After this processing, the image palette is updated.
A message in the status bar indicates the color number before and after processing.

Processing / Smoothing
The smoothing command smooths the image.
The edges became more smooth, and isolated pixels are erased.

Processing / Triangle generation
The triangle generation command generates automatically triangles tiles in an
image, to smooth edges. The crenelated aspect of mosaics is erased.
Before :

After triangle generation :

Palette menu commands
The Palette menu offers the following commands:
View
Shows or hides the image color palette, or the tile color palette.
New tile palette
Create a new tile palette

List of existing palettes.
By selecting the menu item corresponding to the palette name, the palette is
automatically open. A check mark shows the palette in use.

Palettes / View
The view command displays one the two palettes of the software: the image
palette (called image) an the tile palette (called tiles).
The image palette corresponds to colors present on the image. The tile palette
corresponds to tile colors available into a given series.

In the palette grid, the informations of the colors are shown. With the buttons on
the right, you can :
- Insert a new color.
- Suppress a color.
- Save the tile palette into a file.
- Print the tile palette.
- Adjust the options of the palette.
The palette option are :
- Tile size and joint size for this palette.
- Number of tiles corresponding to the price.When the price is given in
surface unit or in weight unit, you have to see how much of tiles there is.
- The tile manufacture name.
To select a color in a palette click on the color in the bar at the bottom of the
screen.

In this bar, a window of 30 colors can be displayed. If there is more colors, then
arrows are drawing at the bottom of the window to navigate into the palette. The
palettes can have at maximum 245 colors.
Shortcuts :
F2 key : Tile palette.
F3 key : Image palette.

Palettes / Marker superimpose
This command superimposes markers for palette display.
Markers are corresponding to the selected option for printing markers (image
numbers, tile numbers or symbols).
A '?' marker is displayed when the image palette is not linked to the tile palette,
and the option for markers is : tile numbers or symbols. To have markers, do a color
reduction processing or select the tile palette which correspond to the mosaic.
Shortcuts : F4 key.

Palettes / New palette
The new palette command create a new tile palette, colors are initialized to the
black color.
Enter the number of colors of the new palette, and the informations for each
color.
The tile palette corresponds to the different colors available for a given
manufacturer and a given serie of tiles.
The software works with several series of tiles.
To use before a new input of a tile palette.

Input of a new tile palette
For the input of a new tile palette, in a first time scan the paper document
showing the palette. Then read values of Red, Green and Blues on the scanned image
for each color (use the scanner software).
Then enter one by one informations of the color in the palette grid.
For each color, enter the RGB value (from 0 to 255), enter the color name given
by the manufacturer, and a symbol for each color (A symbol is composed of 1 or 2
letters, the program avoid to enter two identical symbols).
The printing or the display of a mosaic with the software is not the exact
reproduction of the final mosaic, because the tiles in the program does not have a
texture like the real tiles.

Mosaic menu commands
The Mosaic menu offers the following commands:

Configuration
Adjust of the parameters of the mosaic.

Informations
View mosaic informations.
.
Grid printing
Prints the grids for the mosaic building.

Mosaic / Configuration
The configuration command displays a dialog box for choosing the mosaic
parameters.

Point out the horizontal and vertical grid resolution in number of tiles. The
resolution is depending of the size of the grid of gluing.
The choice of the joint color is concerning the color for the display and the
printing.
The choice of the background color is useful for non rectangular mosaics. The
background corresponds to unvalidate regions. As an example, to generate an image for
the web, you can use as the color background, the color of the page background.
To build a mosaic, we can used the reverse method or the direct method. The
mesh is glued to the back side of the mosaic, so the printing of the grids is reversed
(reverse method). The paper is glued to the front side of the mosaic, so the grids are
printed in the same side than the screen image of the mosaic (direct method).
grids can be numbered from top to bottom or from bottom to top. This last case
is useful for a mosaic on a wall, because they are layed from the bottom to the top of
the wall.
The grid shifting option shifts the grids. It is useful to eliminate the vertical joint
that is sometimes appeared when the grids are aligned.

The printing marker option indicates which markers are used for the printing of
the tile laying plan.
- Image numbers : The software prints grids by making a correspondence
between a number and a color. Numbers are corresponding to colors present on the
image.
- Tile numbers : Same as before. But the numbers are corresponding to the palette
tiles. If we make two different mosaics with the same tile palette, numbers are
corresponding to the same colors on the two laying plans.
- Symbols : The option symbol printing prints the grids by remplacing the
numbers by symbols (1 or 2 letters).
- Colors : For small mosaics (one or two grids), the option color printing can be
used to print the mosaic grids with color. This option increases color ink consumption.
With the option color printing, the mosaic at the real dimension can be printed, to see in
advance the mosaic. The grids have to be cuted and glued each other.

Mosaic / Informations
The informations command displays a dialog box with informations on the
mosaic.

The width, height, total number of grids, resolution of a grid, dimension and the
surface of the mosaic are displayed. For each color of the mosaic, the number of tiles
are computed. The total number of colors used and the price are computed.
To print the informations, press the button Print. Do an information printing
when the mosaic is finished, in the same time as the printing of the tile laying plan.
Informations can be exported in a text file, by a press on the "File text" button, to
be used in a word processing for a quotation. For the text file name, _T is added to the
original name (the extension is .txt).

Mosaic / Grid printing
The grid printing command runs the printing of the grids for the mosaic. The
following dialog box is shown :

A grid is printed on one or several sheets (They should be glued each other).
The option ruler printing prints rulers on each grid.
To print only a given page Y, input Y as the first and the last grid number.
On each sheet, the grid number is printed. The weight of the line drawing
between tiles is equal to the joint size, but it is limited to 0.8 mm to diminish the ink
consumption.

Help menu commands
The Help menu offers the following commands, which provide you assistance
with this application:
Help Topics
Offers you an index to topics on which you can get help.
About
Displays the version number of this application.

Help / About
Use this command to display the copyright notice and version number of your
copy of Mosaic 2000.

Help / Index
Use this command to display the opening screen of Help. From the opening
screen, you can jump to step-by-step instructions for using Mosaic 2000 and various
types of reference information.
Once you open Help, you can click the Contents button whenever you want to
return to the opening screen.
Shortcut:
Key: F1
By clicking on the F1 key when the cursor is on a menu item, the corresponding help
topic is shown.

Glossary
D
Direct method
Method for laying tiles using gummed paper to join tiles. The paper is glued on the
front of the mosaic. The paper is take off after the laying with hot water.

J
Joint
Space between tiles. It can be of different colors. A white joint with white tiles doesnt
spring back tiles.

M
Mesh
Grid in glass fibre for joining tiles in the reverse method.

P
Palette
Color set of an image, or color set of a tile serie.
Pixels
Picture elements.

R
Reverse method
Method for laying tiles using a mesh to join tiles. The mesh is glued on the back of the
mosaic.

T
Tesserae
The basic unit of mosaics (tiles)

